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In Teil 1 dieser Serie wurden das Interface von Modo sowie die Erstellung einfacher geometrischer Formen kurz vorge-
stellt. Darauf aufbauend wird im Folgenden das Modellieren einer SciFi-Ampel behandelt. Hierzu wird die Erstellung des 
Grundkörpers der Ampel ausführlich erklärt, um alle notwendigen Techniken zu versammeln. von Patrick Möchel

Für den ersten Schritt bietet sich das 
Capsule-Tool an (linker Bildschirmrand 
> Basic > linke Maustaste auf dem 

Zylindersymbol gedrückt halten > Capsule 
auswählen). Nach dem Aufziehen des Pri-
mitives auf dem Nullpunkt der Szene bietet 
sich ein Blick in die Item-Liste an (rechter 
Bildschirmrand oben). Hier ist nun eine Sze-
neninstanz namens „Mesh“ zu sehen. Dieser 
Container beinhaltet die soeben erstellte 
Geometrie. Als nächstes soll ein einfacher 
Cube erstellt werden (siehe Abb. 3). 

Dieser wird nun per Doppelklick im Po-
lygonmodus (Taste „3“) vollständig ausge-
wählt. Mittels Strg+X wird die Auswahl in 
die Zwischenablage kopiert. Nun kann per 
Drücken der Taste „N“ auf dem Keyboard ein 
neuer Container erstellt und die Zwischen-
ablage per Strg+V eingefügt werden. 

Hierbei fällt nun auf, dass der neue Mesh-
Container im sogenannten aktiven Modus 
ist, d.h. er ist ausgewählt. Der inaktive Con-
tainer wird im Viewport lediglich als Wire-
frame dargestellt. Die visuelle Darstellung 
aktiver und inaktiver Meshes kann in den 
„3D Viewport Properties“ (Tastaturkürzel 
„O“) eingestellt werden. Container können 
beliebig benannt werden: rechte Maustaste 
auf die entsprechende Zeile im Items-Fen-
ster „Rename“.

Booooleans!

Durch das Unterteilen der Geometrie in 
zwei verschiedene Mesh-Container wird 
der folgende Schritt erst ermöglicht: das 
Beschneiden der Capsule mittels Booleans. 
Die entsprechende Schaltfläche findet sich 
im linken Bildschirmbereich unter MeshEdit 
> Boolean. Mit ausgewähltem Capsule-Con-
tainer sind nun Substract als Operation und 
Background (also das inaktive Mesh) für das 
Drive Mesh zu wählen. 

Die nun entstandene 
Schnittkante kann per 
Ver tex-Normal-Toolkit 
geglättet werden – ver-
gleiche Abb. 4. Für den 
Beschnitt der Rückseite 
der Capsule muss nicht 
unbedingt eine erneute 
Boolean-Operation aus-
geführt werden, statt-
dessen kann der bereits 
bearbeitete Bereich auch 
einfach gespiegelt wer-
den. Hierzu lohnt es, 
sich zuerst mit den Se-
lektionsmöglichkeiten in 
Modo vertraut zu ma-
chen. Nachdem der zu 

löschende Bereich nun 
ausgewählt und per Entf-
Taste entfernt wurde, 
kann die Geometrie ge-
spiegelt werden. Hierzu 
wird das Action Center auf 
„Origin“ gesetzt, wie in 
Abb. 5 gezeigt. Nach dem 
Drücken von Strg+C wird 
die Geometrie um -100% 
(negativ) über die blaue 
Achse skaliert. Da sich die 
Orientierung der Face-
Normals nun durch das  
negative Scaling umge-
dreht hat, müssen diese 
bei ausgewählten Poly-
gonen per Tastenkürzel 
„F“ geflippt werden. 

Strg+V fügt die zuvor 
in die Zwischenablage ko-

pierte ursprüngliche Geometrie wieder ein. 
Per Alt+Shift+A werden alle Vertexpunkte 
ausgewählt, um die an der Spiegelkante 
liegenden Punkte per „Vertex“-Reiter (lin-
ke Bildschirmseite) > Merge miteinander zu 
verschmelzen.

Dies leitet zum nächsten wichtigen Punkt 
über: den verschiedenen Auswahlmodi. Die 
Auswahl einzelner oder zusammenhän-
gender Polygone, Faces oder Vertices kann 
komfortabel mit gedrückter linker Maus-

Modo für Game Art –  
Erstellen eines Game Props in Modo Teil 2

Abb. 3: Mesh-Container 
– Modo behandelt Geo-
metrie nicht als einzelne 
Instanz, sondern arbei-
tet mit Containern. Pro 
Szene sind beliebig viele 
Container möglich. Zwi-
schen einzelnen Contai-
nern lässt sich beliebige 
Geometrie (z.B. einzelne 
Polygone oder ganze 
Objekte) per Strg+X/C/V 
hin- und herkopieren.
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taste gepaintet werden. Zum Deselektie-
ren wird die Strg-Taste verwendet, für die 
Auswahl weiterer Komponenten Shift. Um 
ein komplettes Item auszuwählen, genügt 
ein Doppelklick auf ein beliebiges Polygon 
im Face-Mode. Edgeloops werden ebenfalls 
per Doppelklick ausgewählt, jedoch bei ak-
tiviertem Edge-Mode. Vertices können z.B. 
per Lasso mittels gedrückter rechter Mausta-
ste ausgewählt werden. Das Vergößern und 
Verkleinern einer Auswahl erfolgt mittels 
Shift-Pfeiltaste nach oben bzw. unten.

Im nächsten Schritt soll der Lampenmast 
erstellt werden. Hierzu werden, wie in Abb. 
6 zu sehen, die oberen Faces des Grund-
körpers ausgewählt, Shift+X aktiviert das 
Extrude-Tool. Mit einem kurzen Klick der 
rechten Maustaste wird das Tool ausgelöst – 
die nun extrudierten Polygone befinden sich 
jedoch noch genau an ihrer Ursprungspositi-
on. Per „R“-Taste wechselt man direkt in das 
Scale-Tool, um die neu entstandenen Faces 
zu verkleinern, mit „W“ verschiebt man die 

extrudierten Faces. Die Operation wird durch 
das Drücken der Leertaste beendet.

Weitere Edge-Loops können mittels 
Reiter Edge > Add Loop eingefügt wer-
den. Hierzu wird das Tool aktiviert, ein zu 
schneidendes Edge-Segment ausgewählt, 
der zu erstellende Edge-Loop ggf. an die 
gewünschte Position verschoben und der 
Vorgang wieder mit der Leertaste beendet. 
Sollen mehrere Edge-Loops gleichzeitig 
eingefügt werden, kann dies mit gedrückter 
Shift-Taste erledigt werden. Ab und zu ge-
staltet sich die Option „Split at the Middle“ 
als recht praktisch. Diese findet sich unter-
halb der Reiterleiste unter Add Loop.

Falls keine ganzen Loops erstellt, sondern 
nur einzelne Polys unterteilt werden sollen, 
bietet sich das Edge-Slice-Tool an. Dies fin-
det sich unter dem Reiter Mesh-Edit oder 
lässt sich schnell und einfach per Tastatur 
mit „C“ aufrufen. Zur Anwendung einfach 
den Start- und Endpunkt auf anliegenden 
Edges anklicken (mit gedrückter Maustaste 

können diese verschoben werden) und mit 
der Leertaste quittieren. Um fehlende Polys 
zu füllen, kann der das Loch bildende Edge-
Ring per Doppelklick ausgewählt und die Ta-
ste Make im Reiter Polygon betätigt werden.

Für die Erstellung der weiteren Geometrie 
sind keine bisher noch nicht aufgeführten 
Techniken notwendig. Bevor es weiter zum 
nächsten Schritt in der Pipeline – dem Un-
wrapping – geht, soll jedoch noch auf die 
sehr komfortable Snapping-Funktionalität 
von Modo eingegangen werden.

Bevor das Snapping per „X“-Taste akti-
viert wird, ist es wichtig, das Action-Center 
zurück auf den Automatic-Modus zu stellen. 
Die Snapping-Optionen werden per „F11“ 
aufgerufen, Vertex- und ggf. Grid-Snapping 
reichen in den meisten Fällen aus. Hier kön-
nen auch die Stufen für den Angle-Snap im 
Rotate-Modus eingestellt werden (Strg wäh-
rend der Rotation gedrückt halten). 

Um nun eine Auswahl an einem Ver-
tex- oder Gridpunkt auszurichten, kann das 
Action-Center einfach an dem hellblauen 
Kreuz in der Mitte auf den Snappingpunkt 
gezogen werden. Vor dem Verschieben kann 
das Action-Center per Mausklick auf belie-
bige Punkte wie z.B. einen Vertexpunkt der 
zu verschiebenden Geometrie platziert wer-
den (siehe Abb. 7).

Unwrapping

Für die ansprechende Darstellung der Ober-
flächen unserer Geometrie benötigen Game 
Engines Texturen. Hierbei handelt es sich um 
Bitmap-Grafiken zur Darstellung von Farbe 
(Diffuse oder Albedo) und Reflektionsstärke, 
welche auf die Polygone projiziert werden. 
Dafür wird ein UV-Layout benötigt, quasi die 
Tapete unseres Assets; man kann es sich wie 
Papercraft-Modelle vorstellen.

Abb. 4: Booleans & Vertex 
Normal Toolkit Script

Abb. 5: Achsen-
symmetrisches 
Spiegeln und 
Copy-and-paste

Abb. 6: Extrudieren step-by-step
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Um ein solches UV-Layout zu erstellen - 
man spricht bei diesem Prozess auch von 
Unwrapping - müssen die Schnittkanten des 
Unwraps in Modo definiert werden. Hierzu 
genügt es, im UV-Layout-Tab sämtliche 
entsprechenden Edges im Viewport zu mar-
kieren und in der Tool-Leiste auf der linken 
Seite die Schaltfläche Unwrap Tool anzukli-
cken. Das so auf der linken Bildschirmhälfte 
entstandene UV-Layout muss nun auf den 
sogenannten 0-1-Bereich der Arbeitsfläche 
eingepasst werden (siehe Abb. 8). Hierzu 
können in Modo Einzelkomponenten nach 
dem gleichen Prinzip wie bei Geometrie im 
Viewport ausgewählt und angepasst werden. 
Falls einzelne Teile nicht ordentlich horizon-
tal oder vertikal ausgerichtet sind, schafft 
der Button „Orient Pieces“ Abhilfe. Um das 
Streckungsverhältnis zu korrigieren, zieht 

man die Maus mit gedrückter linker Mausta-
ste über einen freien Bereich im UV-Fenster, 
nachdem der Button „UV-Relax“ gedrückt 
wurde. Bei komplexer Geometrie empfiehlt 
es sich, das Asset in mehrere Mesh-Contai-
ner zu unterteilen und die so entstandenen 
Subkomponenten des Props Stück für Stück 
abzuarbeiten.

Es ist wichtig, darauf zu achten, so wenig 
ungenutzten Platz wie möglich im UV-Lay-
out zu lassen, da die Bitmap-Texturen immer 
als Ganzes in den Arbeitsspeicher der Gra-
fikkarte geladen werden und nicht projizierte 
Pixel so unnötig Speicher verbrauchen.

Ebenso wichtig ist es, eine einheitliche 
Texel-Density zu definieren, um eine gleich-
mäßige Größe der einzelnen Pixel über das 
gesamte Modell zu garantieren. Hierbei hilft 
das Texel Density Script, dessen Installation 
in Teil 1 erörtert wurde.

Ein weiterer unverzichtbarer Helfer ist 
das Script „ETEREA UV Tools“ (siehe Abb. 
9). Hiermit können z.B. Faces voneinander 
getrennt (vierter Button in der dritten Rei-
he) und UV-Isles zusammengefügt werden 
(eine der beiden zu verschmelzenden Edges 
auswählen und den fünften Button in der 
siebten Reihe klicken). Sämtliche Buttons 
werden per Tooltip beschrieben, wenn man 
mit dem Mauszeiger über ihnen verweilt.

Zusätzlich zum gerade erstellten UV-Layout 
benötigt die Unreal Engine noch ein zusätz-
liches UV-Layout für die Darstellung von 
Lightmaps, welche Informationen zu indivi-
duellen Umgebungsschatten enthalten. Zu-
sätzliche UV-Kanäle können im Tab „Lists“ 
(rechter unterer Bildschirmbereich) unter 
„UV Maps“ erstellt werden. Hierzu einfach 
auf „(new map)“ klicken. Per Rechtsklick auf 
die entsprechenden Zeilen in der Liste kön-
nen UV-Layouts zwischen den Slots hin- und 
herkopiert werden. Achtung bei Lightmaps: 
UV-Isles dürfen sich nicht überschneiden 
und einzelne Faces nicht übereinander lie-
gen, da es sonst zu Darstellungsfehlern in 
der Lightmap kommen kann.

Color-ID Baking

Das Erstellen einer Color-ID-Map vereinfacht 
den späteren Texturierungsvorgang. Hier-
für müssen den einzelnen Polygongruppen 
Farben zugewiesen werden. Jede einzelne 
Farbe repräsentiert hierbei ein Material (z.B. 
Plastik oder Metall) – siehe Abb. 10. Um ein 
Material zuzuweisen, müssen erst die einzu-
färbenden Polygone ausgewählt werden. Die 
Taste „M“ öffnet den Dialog zum Zuweisen 
von Materialien. Im Feld „Name“ kann eine 
eindeutige Bezeichnung, z.B. Metall, hinter-

Abb. 7: Snapping

Abb. 8: Einfaches UV-Layout – die Schnittkanten sind orange hervorgehoben.

Abb. 1O: UV-Layout und Color-IDs

Abb. 9: Script – ETEREA UV Tools
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legt werden. Ein Klick auf das Feld „Color“ 
öffnet ein Farbauswahlfenster. Durch das 
Angeben eines neuen Namens wurde nun 
ein neues Material im Shader-Tree angelegt, 
zu sehen in der Kartei „Shading“ im rechten 
oberen Bildschirmbereich.

Um ein bereits bestehendes Material zu-
zuweisen, reicht es, im Dialog „Polygon Set 
Material“ in der Namensliste ein bereits be-
stehendes Material auszusuchen.

Zum Erstellen der Color-ID-Map wird  
zuerst ein Render Output für „Final Color“ 
benötigt (Tab Shading > Dropdown-Menü 
Add Layer > Render Outputs > Material > 
Diffuse Color). Die Größe des zu berech-
nenden Bitmaps wird ebenfalls im Shader-
Tree eingestellt: Render (blaues Kugelsym-
bol) auswählen > Properties-Tab > Bake 
Width und Height (ganz unten, möglicher-
weise hinter dem Doppelpfeil an der unteren 
linken Bildecke versteckt). Die Berechnung 
wird über die Menüleiste oben am Fenster 
gestartet: Render > Bake to Render Outputs. 
Falls Modo die Fehlermeldung „No current 
UV map“ ausgibt, muss im Lists-Tab unter 
„UV Maps“ die erste Texure Map ausge-
wählt werden (nur nach Programmneustart). 
Nach Fertigstellung des gerenderten Bakes  

sollte der Farbraum noch auf sRGB umge-
stellt werden: Reiter „Image Processing“ 
im Render-Fenster (rechte Seite) > Output  
Color Space (ganz unten) auf sRGB (zur Vor-
schau: Dropdown-Liste „LUT“ in der oberen 
Leiste > sRGB). Das fertige Bild muss nun mit 
dem Button „Save Image“ (links unten) als 
Bitmap-Datei (z.B. .png) auf die Festplatte 
gespeichert werden.

Ambient Occlusion

Im nächsten Teil dieser Serie wird das Tex-
turieren in Photoshop und die Integration 
in die Unreal Engine betrachtet. Zuvor soll 
jedoch noch eine Ambient Occlusion Map 
erstellt werden. Bei einer AO-Map han-
delt es sich um eine Textur, in welcher die 
aufgrund der geometrischen Eigenschaften 
des Meshes entstehenden Schatten gespei-
chert sind. Dies verhilft zu mehr Tiefe in der 
Diffuse-Map und lässt das Asset plastischer 
erscheinen (vgl. Abb. 11).

Wie auch für die Color-ID-Map wird für 
die AO-Map ebenfalls ein eigener Render 
Output benötigt (Tab Shading > Dropdown-
Menü Add Layer > Render Outputs > Lighting 
> Ambient Occlusion). Falls sich in der Szene 

Mesh-Container befinden, die vom Rende-
ring ausgenommen werden sollen, müssen 
diese versteckt werden (kleines Auge links 
in der entsprechenden Zeile). Bevor der Ren-
derprozess gestartet wird, bietet es sich an, 
alle Outputs außer Ambient Occlusion im 
Shader-Tree per Klick auf das kleine Auge 
links in der Zeile zu deaktivieren.

Nun kann die Berechnung über „Bake 
to Render Outputs“ gestartet werden. Falls 
vorher nicht alle Render Outputs, abgesehen 
von Ambient Occlusion, deaktiviert wurden, 
kann in der oberen Zeile des Renderfensters 
unter der Dropdown-Liste Output „Ambient 
Occlusion Output“ manuell ausgewählt wer-
den. Mit dem Speichern des Render Outputs 
in ein Bitmap ist die Ambient Occlusion Map 
(siehe Abb. 12) für den Texturiervorgang im 
nächsten Teil dieser Serie vorbereitet. › ei

Patrick Möchel ist Head Instructor für den 
Bereich Game Art am SAE Institute Ham-
burg. Zuvor arbeitete er als Environment 
Artist für die Firma Sony bei Guerrilla 
Games Amsterdam an den Playstation-
4-Titeln „Killzone: Shadow Fall“ und 
„Horizon: Zero Dawn“ sowie für die Firma 
Crytek GmbH in Frankfurt am Main. Hier 
trug er als 3D-Artist neben anderen Pro-
jekten zu „Crysis 2“ bei.

Abb. 12: Die fertige Ambient Occlusion MapAbb. 11: Render-Mesh ohne und mit zugewiesener Ambient Occlusion Map
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